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SUMMARY

Peroxisome biogenesis disorders (PBDs) represent a group of metabolic conditions that cause severe devel-
opmental defects. Peroxisomes are essential metabolic organelles, present in virtually every eukaryotic cell
and mediating key processes in immunometabolism. To date, the full spectrum of PBDs remains to be iden-
tified, and the impact PBDs have on immune function is unexplored. This study presents a characterization of
the hepatic immune compartment of a neonatal PBD mouse model at single-cell resolution to establish the
importance and function of peroxisomes in developmental hematopoiesis. We report that hematopoietic de-
fects are a feature in a severe PBD murine model. Finally, we identify a role for peroxisomes in the regulation
of the major histocompatibility class II expression and antigen presentation to CD4+ T cells in dendritic cells.
This study adds to our understanding of the mechanisms of PBDs and expands our knowledge of the role of
peroxisomes in immunometabolism.

INTRODUCTION

Peroxisomes are essential metabolic organelles present in virtu-

ally every eukaryotic cell. In mammals, peroxisomes are the

cellular compartments where unique lipid metabolic processes

occur, such as b-oxidation of very-long-chain fatty acids

(VLCFAs), a-oxidation of fatty acids, and synthesis of ether

lipids.1,2 Peroxisomes also regulate the synthesis and turnover

of reactive oxygen and nitrogen species and contribute to the

metabolism of polyamines, carbohydrates, and amino acids,

making this organelle an essential regulator of cellular meta-

bolism.1 Peroxisome biogenesis, fission, andmaturation through

the import of proteins into the peroxisome matrix depend on a

set of peroxin (PEX) proteins.3 Mutations in the genes encoding

PEX proteins impair peroxisome biogenesis and function and un-

derlie a clinical spectrum of disorders known as peroxisome

biogenesis disorders (PBDs).

PBDs are divided into two distinct syndromes: the Zellweger

syndrome spectrum (PBD-ZSS) and the rhizomelic chondro-

dysplasia punctata spectrum (PBD-RCDP). Except for the

Pex7 mutation underlying most cases of PBD-RCDP, most

other Pex gene mutations result in generalized peroxisome

dysfunction and the PBD-ZSS phenotype.4 The metabolic dys-

functions that arise in PBD-ZSS often affect the development

of multiple organs, including the brain, liver, kidneys, and

muscles.

Atypical phenotypes have recently been described for these

phenotypic groups, indicating that the full spectrum of these dis-

orders remains to be identified. For instance, case studies

described patients with PBD-ZSS presenting defects in T cell dif-

ferentiation.5 The patients exhibited thymic hypoplasia and

poorly developed T cell-dependent zones in all examined lymph

nodes and spleen. One patient was affected by sepsis and died

after 7months of pneumonitis. Recently, a case of a newborn pa-

tient with PBD-ZSS who died of gram-negative fulminant sepsis

was reported.6 The infant had a low total white blood cell count,

particularly neutrophils. Additionally, a case study of a 2-month-

old infant with PBD-ZSS who presented with lymphopenia,

thymic atrophy, and several recurrent opportunistic infections

has been described.7
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Although these studies demonstrate that a link exists between

peroxisome function and the development and function of im-

mune cells and that the poor prognoses of patients with PBD-

ZSS are partly a consequence of defective immune development

that results in infectious respiratory morbidity and sepsis, to

date, no study has globally analyzed the role of peroxisomes

on hematopoiesis in severe PBD-ZSS. Over the past 15 years,

evidence has supported the hypothesis that peroxisomes are or-

ganelles of immunometabolism and that their activity can regu-

late different aspects of immunity in health and disease.8 Perox-

isome-derived ether lipids are required for neutrophil survival

and development in mice.9 These findings could partly explain

why some patients with PBD-ZSS present with neutropenia. A

requirement for ether lipids in the education, differentiation,

and maturation of invariant natural killer T (iNKT) cells in the

thymus has also been reported.10 Moreover, peroxisomes

have been directly linked to specific functions in innate and

adaptive immune cells such as phagocytosis,11 cytokine

release,12–15 and the production of immunoglobulin M (IgM) by

innate B cells.16 Thus, both clinical case studies and studies in

animal models suggest that immune disorders could be a feature

of PBD-ZSS.

The Pex2 homozygous (Pex2�/�) null mouse is a useful murine

model of severe PBD-ZSS. Pex2�/� mice carry an insertion or

deletion mutation in the gene that encodes for Pex2, a ubiquitin

ligase,17 that, if mutated, affects the import of peroxisomal en-

zymes into the matrix, leading to peroxisome biogenesis de-

fects.3 The Pex2�/� murine mouse was previously described18

and showed canonic neurodevelopmental phenotypes typical

of PBD-ZSS. Moreover, our recent study reported that Pex2�/�

bone marrow-derived macrophages (BMDMs) exhibit defects

in phagocytosis and inflammatory cytokine secretion upon stim-

ulation with pathogens.12

To provide a more comprehensive study of the hematopoietic

defects caused by peroxisomal deficiency that may underlie the

observed immune disorders of PBD-ZSS, we performed a global

examination of immune cell development in the liver of a Pex2�/�

model of PBD-ZSS using single-cell RNA sequencing (scRNA-

seq). The liver is the main hematopoietic organ during gestation

and a reservoir for developing immune cells for almost a week af-

ter birth.19,20 Our results demonstrated that Pex2�/� PBD-ZSS

mice have hematopoietic defects detectable in myeloid and

lymphoid cells. Additionally, we demonstrated that peroxisome

metabolism is required for the activation of protein kinase C-

d (PKC-d) to drive major histocompatibility complex class II

(MHC class II) surface expression on dendritic cells (DCs) for

effective antigen presentation to CD4+ T lymphocytes. This

study defines immunometabolic requirements for peroxisomes

in DCs and in regulating antigen presentation, an event that

has an implication also for the activation of adaptive immunity.

RESULTS

Hepatic immune cell atlas of WT and Pex2�/� mice at
single-cell resolution
To map the hepatic immune cell landscape in a neonatal Zell-

weger murine model, we isolated CD45+ cells from livers

dissected from wild-type (WT), Pex2 heterozygous (Pex2Het),

and Pex2�/� null mutant mice at postnatal day 0 and prepared

these cells for scRNA-seq (Figure 1A). Although some of the

Pex2�/� homozygous mice were reported to survive up to

15 days postbirth,21 in our hands, Pex2�/� homozygous mice

were lethal with high expressivity and penetrance after postnatal

day 0, and therefore we used this time point in our study to cap-

ture the developmental defects that persist after birth. We

focused on the liver because it is the major hematopoietic tissue

at this developmental stage and can better reveal the effect that

peroxisome dysfunction might have on the immune system of

patients with Zellweger. The distribution of each genotype in

the clustering of CD45+ day 0mouse liver cells is represented us-

ing dimensional reduction by uniform manifold approximation

and projection (Figure 1B). The expression of the Pex2 transcript

across these clusters is relatively universal in the hepatic immune

subsets of WT and Pex2Het mice and is completely abolished in

Pex2�/� mice (Figure 1C). To assign cell-type classifications to

our scRNA-seq results, we used two-dimensional hierarchical

clustering across the most variable genes and used lists of

cell-type markers from related scRNA transcriptomics and

developmental studies of hepatic immune cell types19,20,22–26

to annotate cell types (Figure 1D and S1A; Tables S1 and S2).

Our scRNA-seq results show distinct transcriptional profiles

consistent with 19 different immune cell populations, which

can be clustered in subpopulations that express markers typical

of fully differentiated cells or of cells still in differentiation or fea-

tures of stemness and exhibit immune expression profiles largely

similar to those previously reported in the mouse neonatal liver

immune cells (Figures 1D, 1E, and S1B).19,20 Neutrophils, B

cell lineages, monocytes, and myeloid subsets of DCs and

Kupffer cells comprised most of the immune cells present in

the neonatal livers ofWT, Pex2Het, and Pex2�/�mice. Small clus-

ters of cells with NK (natural killer)/T cell-like expression, baso-

phils, erythroid lineages, and megakaryocytes are also identifi-

able in each genotype (Figure 1E).

The subclustering of major immune cell subsets allowed us to

further define distinct subpopulations of developing hematopoi-

etic cells, including clusters with gene signatures that resemble

granulocyte monocyte progenitor (GMP) cells20 and monocyte-

DC progenitors (MDPs) (Table S2).20,27–31 The GMP population

clustered together with immature neutrophil (iNP) and monocyte

populations, two lineages that arise from GMP differentiation,

and MDPs clustered closely with DCs and monocytes, reflecting

their developmental association with these lineages (Figure 1E).

Similarly, we examined the neutrophil cluster and identified gene

signatures consistent with previously reported developmental

stages of mature neutrophils (mNPs), which show high expres-

sion of Mmp9, Arg2, and Retnlg; intermediate mNPs, which

exhibit high expression of granule protein encoding genes Ltf

and Ngp; and immature iNPs, which express Cebpe and Camp

but also display overlapping expression profiles with GMP cells,

with the expression of Elane and Mpo. Each of these neutrophil

clusters also exhibited an expression of markers of activation

such as Cd177 and S100a8/a9,32 a phenotype reported for

neutrophilic lineages in the neonatal liver.18 The monocyte pop-

ulation was found to express monocyte-associated genes such

as Vcan31 and Fn133 and monocyte/macrophage-associated

genes Fcgr1 and Csfr1. We also identified a very small
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population of basophils by their expression of Cd200r3, Prss34,

and Cebpa34 (Figures 1E and S1A; Tables S1 and S2).

Analysis of the B cell population (Cd19-, Rag1-, and Cd79a/b-

expressing cells) revealed several subpopulations, of which a

majority in day 0 mice exhibited an immature expression profile

of pro-B and large pre-B cells, with a prominent expression of

IgM heavy chain, Rag2, and Vpreb1 (Figures 1E and S1A;

Tables S1 and S2). A subset of small pre-B cells could be distin-

guished from other subsets by the expression of Fcmr,35 while

mature B cells exhibited higher expression of Bach2.36

Also, although the liver is considered a lymphoid organ in

adults and part of T cell development occurs in the liver of em-

bryonic day 13-stage mice with T cell progenitors migrating to

the thymus,37 we found a residual pool of cells with NK/T cell-like

A

B C

D E

Figure 1. Transcriptional profiling of hepatic immune cell subsets of neonatal WT, Pex2Het, and Pex2�/� mouse livers

(A) Diagram of the experimental pipeline of the single-cell analysis.

(B) Uniform manifold approximation and projection (UMAP) clustering of the integrated datasets representing the identified cellular clusters and cell types of the

hepatic immune cells of WT, Pex2Het, and Pex2�/� mice.

(C) Distribution of Pex2 expression across UMAP clusters of WT, Pex2Het, and Pex2�/� mice.

(D) Heatmap of select differential genes used to identify cluster types across all identified cells.

(E) Cell-type annotation of UMAP cluster of WT, Pex2Het, and Pex2�/�.
n = 2 mice per genotype.

See Figure S1 and Tables S1 and S2.

Cell Reports 43, 113744, February 27, 2024 3

Article
ll

OPEN ACCESS



A

B C

D

(legend on next page)

4 Cell Reports 43, 113744, February 27, 2024

Article
ll

OPEN ACCESS



expression (Ncr1, Klra5, Tbx21, Grzma, Grzmc, Fasl) but that

could not be individually distinguished asNK or T cells. Together,

these data suggested that granulocytes, B cells, monocytes, and

DCs are the most abundant immune cells in the neonatal hepatic

immune environment.

We identified the conventional DC (cDC) populations cDC1

and cDC2 in the liver of all genotypes, with the distinct expres-

sion of genes such as Itgae, Tlr11, Clec9a, and Cd74 in cDC1s

and Itgax, Batf3, and Ly6a in cDC2s, as well as plasmacytoid

DCs (pDCs) denoted by the expression of gene markers such

as Siglech, Klk1, and Ccr938–40 (Figures 1E and S1A; Tables S1

and S2). The genes Marco and Clec4f41 were highly expressed

in Kupffer cells, a relatively small population of cells in the

neonatal liver, which is not unexpected, as they are not as

numerous as other cell types, and their presence increased a

few days postbirth.19

Pex2�/� mice display compositional defects in the
hepatic immune compartment
Todetermine if Pex2plays a role in thedevelopment of any hepat-

ic immune population, we assessed the proportion of each cell

type identified in the scRNA-seq of neonatal mice of each geno-

type. Accounting for the difference in size of postnatal day

0Pex2�/�micewith anaverageweight of 1gcompared toPex2He

and WT (1.4 and 1.6 g, respectively) littermates, we observed a

decrease in the proportion of B and large pre-B cells of both

Pex2Het and Pex2�/� mice compared to WT mice, representing

the largest decrease in any cell population, whichwas contrasted

by an increase in the pro-B and small pre-B populations (Fig-

ure 2A). Similarly, we observed a modest increase in the NK/T

cell-like population in Pex2Het and Pex2�/� mice. This shift

in B cell numbers toward a larger immature B cell population in

Pex2Het and Pex2�/� mice suggests a dominant role for Pex2 in

B cell development. Assessing changes that are exclusive to

the Pex2�/� mice, we observe a notable decrease in the propor-

tion of GMPs and a greater proportion of Kupffer cells andmono-

cytes in Pex2�/� compared toWT and Pex2Het mice, and a step-

wise increase in erythroblasts and adecrease inmegakaryocytes

was observed across WT, Pex2Het, and Pex2�/� mice, while no

trends in the changes in any other cell population were observed

(Figure 2A).

Global GSEAs of the hepatic immune population reveal
developmental and functional defects characteristic of
peroxisomal dysfunction
To capture the overarching changes in the hepatic immune

compartment of Pex2�/� mice, we mapped the network of the

cellular processes found to be enriched among the differentially

expressed genes of Pex2�/� compared to WT immune cells

(Figures S2 and S3; Tables S3 and S4). We used differential

gene expression analyses of genes in Pex2�/� compared to

WT for each cell type, analyzed together or separately

(Tables S3 and S5). Gene set enrichment analysis (GSEA) of

the processes and pathways enriched from differentially ex-

pressed genes of Pex2�/� compared to WT revealed that muta-

tion in Pex2�/� has effects on mitochondrial-associated pro-

cesses such as oxidative phosphorylation, the citric acid and

TCA cycles, the electron transport chain, and the ATP biosyn-

thetic process and on processes associated with protein meta-

bolism such as translation, purine metabolism, and cytoplasmic

and mitochondrial ribosomal proteins (Figure S2A). These en-

richments align with previously reported RNA-seq transcrip-

tomic profiles of peroxisome dysfunction models in Drosophila

and mice.12,42 We also found that genes belonging to the amino

acid catabolic processes and fatty acid b-oxidation were down-

regulated inPex2�/�mice (Figure S2B), while genes encoding for

enzymes of glycerophospholipid metabolism and glycolipid

metabolism were upregulated in Pex2�/� mice (Figure S2B).

Additionally, we found that a cellular network of processes asso-

ciated with cortical actin cytoskeleton and Rho GTPase cycle

regulation and MAPK signaling were enriched among genes

that were upregulated in Pex2�/� immune cells (Figures S2C

and S2D), which agrees with similar findings in Drosophila im-

mune cells.12

Given the observed transcriptional changes in the cellular

process of Pex2�/� hepatic immune cells, we assessed

whether the expression of genes encoding peroxisome-associ-

ated proteins was altered in Pex2�/� mice. The peroxisomal

biosynthetic genes Pex5, Pex6, Pex10, Pex11b, Pex12,

Pex16, and Pex19 exhibited lower expression in B cell lineages

(pro-B, large pre-B, and B) and the cDC1 subset of Pex2�/�

mice compared to WT mice, while, conversely, the expression

of these PEXs was higher in nearly every other immune cell

type in Pex2�/� mice (Figure S2E). The expression of Pex1,

Pex3, Pex7, and Pex13 was lower in these B cell lineages but

higher in cDC1 and most other immune subsets in Pex2�/�

mice. Notably, the expression of Pex11a was higher in nearly

all hepatic immune subsets of Pex2�/� mice, while Pex11g

was broadly lower.

Altogether, these data confirmed that liver immune cells from a

Pex2�/� PBD-ZSS mouse model exhibit gene enrichment pro-

files typical of cells with defects in peroxisomal metabolism.12,42

Our analyses also show that genes required for the develop-

ment and functions of immune cells (e.g., ‘‘negative regulation

of lymphocyte differentiation,’’ ‘‘myeloid cell development’’)

are positively enriched in the Pex2�/� versus WT hepatic im-

mune cells as well as immune processes (e.g., phagocytosis,

cytokine production involved in immune responses, regulation

of myeloid cell activation involved in immune response, and

leukocyte degranulation regulation) (Figure S3A). Conversely,

negatively enriched processes were identified in categories

related to immune functions in the Pex2�/� compared to the

Figure 2. Gene expression profiles in Pex2�/� compared to WT hepatic immune cells suggest developmental delays

(A) Proportion of cell types identified in scRNA-seq analysis of immune subsets relative to the total number of CD45+ cells (top) or relative to the total number of

cells of a specific immune subset (bottom).

(B) GSEA of differentially expressed genes between major cell types identified in WT and Pex2�/� mice.

(C and D) Relative expression of MHC class II encoding and associated genes across (C) four developing B cell subsets and (D) three dendritic cell (DC) subsets.

See Figures S2 and S3 and Tables S3, S4, S5, and S6.
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WT hepatic immune environment (e.g., activation of nuclear

factor-kB [NF-kB] signaling and presentation of exogenous sol-

uble antigens) (Figure S3B; Table S4). Notably, genes involved

in polyamine metabolism are negatively enriched in the Pex2�/�

hepatic environment; this is important because polyamines

have emerged as an important regulator of immune cells’ activ-

ities, and their metabolism occurs in part in peroxisomes (Fig-

ure S3; Table S4).8 The direct role of peroxisome metabolism

in some of the immune functions identified in the GSEA has

been demonstrated in Drosophila (e.g., phagocytosis and

NF-kB signaling)11 and mouse (e.g., phagocytosis and cytokine

production).12,14 The enrichment of these immune processes in

the Pex2�/� immune cells supports the idea that the develop-

ment and function of hepatic immune cells at this stage rely

on peroxisomes.

The differential expression profiles of individualPex2�/�

liver cells reveal altered states of development and
immune processes
To identify changes in cellular processes and programs in major

immune subsets present in the Pex2�/� neonatal liver, we per-

formed GSEA on the genes with significant differential expres-

sion compared to WT mice. We assessed these enrichments

across three groups of cells: the GMP and neutrophil group,

the myeloid/monocyte group containing GMPs, MDPs, DCs,

monocytes, and Kupffer cells, and the group of developing B

cells.

Generally, GMPs, as well as all the developing neutrophil sub-

sets of Pex2�/� compared to WT, showed a positive enrichment

of several lipid metabolic gene sets (e.g., fatty acid catabolism,

steroid catabolism, ether lipid metabolism, etc.) and immune

pathway gene sets (e.g., NLRP3 inflammasome assembly, regu-

lation of the tumor necrosis factor [TNF] signaling pathway, and

antifungal innate immune response). More mNP subsets were

positively enriched in gene sets associated with the production

of and response to immunoactive molecules (e.g., prostaglandin

secretion, eicosanoid metabolism, interleukin-8 [IL-8] produc-

tion, and complement activation). By contrast, the GMPs, as

well as all the developing neutrophil subsets of Pex2�/�

compared to WT, collectively showed a negative enrichment in

gene sets associated with cell differentiation, calcium release,

IL-4 production, antigen presentation, and VLCFA metabolism.

The GMPs and more iNP subsets were negatively enriched in

genes associated with cell differentiation and cell division, sug-

gesting that granulocyte differentiation programs of the hepatic

precursor cells are affected in the severe PBD-ZSS model (Fig-

ure 2B; Table S6).

The GSEA patterns within the myeloid/monocyte group of

Pex2�/� compared to WT show a positive enrichment of gene

sets associated with innate immune regulation and Toll-like re-

ceptor (TLR) signaling in GMPs, MDPs, all DCs, and Kupffer cells

but negatively enriched in monocytes (Figure 2B; Table S6). The

MDP, DCs, and Kupffer cells were also positively enriched in

gene sets associated with TNF and chemokine production,

MAPK and Notch signaling, and cell migration, while GMPs

and monocytes were negatively enriched in these processes.

cDCs, cDC1s, and cDC2s were negatively enriched in gene

sets associated with the actin cytoskeleton, microtubule pro-

cesses, receptor-mediated endocytosis, and antigen process-

ing and presentation by MHC class II (Figure 2B; Table S6).

The developing subsets of B cells in Pex2�/� mice, including

pro-B, large pre-B, small pre-B, and B, show an enrichment of

upregulated genes associated with plasminogen activation,

negative regulation of coagulation, phosphatidylinositol dephos-

phorylation, and cholesterol efflux (Figure 2B; Table S6). Across

the more mature B cell subsets, there is a positive enrichment of

the downregulated genes in Pex2�/�mice, which are associated

with eicosanoid and fatty acid synthesis, leukotriene meta-

bolism, glycerophospholipid catabolism, and IL-12 production.

Pro-B cells in Pex2�/� mice, by contrast, were enriched in genes

upregulated in these processes. Likewise, the immature B cell

subsets in Pex2�/� mice were enriched with genes associated

with immune processes such as antifungal, antimicrobial, and

humoral immune responses; IL-1b production; phagosome

maturation; and antigen processing and presentation via MHC

class II (Figure 2B; Table S6). These processes were negatively

enriched in mature B cells, suggesting that mature B cells have

defective immune response processes and are deficient in

MHC class II antigen presentation. The enrichment of the pro-

cess of MHC class II antigen processing and presentation

among downregulated genes of both the Pex2�/� B cells, DC

subsets, and neutrophils led us to assess the expression level

of specific MHC class II presentation-associated genes in the

B and DC subsets. We found that the MHC class II-associated

and encoding genes H2-Aa, H2-Ab1, H2-Eb1,H2-Eb2, and Ciita

were downregulated in mature B cells (Figure 2C). Likewise, all

DC subsets, cDC1s, cDC2s, and pDCs exhibited a downregula-

tion in most of these genes (Figure 2D).

In conclusion, GSEAs of the differential gene expression be-

tween Pex2�/� versus WT across all the analyzed immune cell

groups suggest lipid metabolic defects, including lipid media-

tors, cytoskeleton alteration, and deregulation of immune and

inflammatory genes, in mature cells. Interestingly, all immune

cell precursors show negative enrichments in genes involved

in differentiation but a positive enrichment in genes encoding

for immune and inflammatory signaling. On the other hand,

the enrichment analyses of the downregulated genes in the

mutant versus WT mature immune cell populations show de-

fects in immune effector functions (e.g., phagocytosis or anti-

gen presentation). Of interest was the significant downregula-

tion in antigen-presenting genes in mature B cells and DC

subsets.

Flow cytometry corroborates developmental defects in
myeloid cells and B cells
To validate the scRNA-seq results, we characterized select

neonatal liver immune cells of WT and Pex2�/� pups by flow cy-

tometry analysis (gating strategy: Figures S4A–S4C). By staining

for cell surfacemarkersCD11b, Ly6C, and Ly6G,we identified an

increase in the proportion of GMPs (CD11b+Ly6CloLy6Glo) and a

decrease in the proportion of neutrophils (CD11b+Ly6CloLy6Ghi)

among all viable CD45+ liver immune cells of Pex2�/� mice

compared to WT littermates (Figures 3A–3C). We did

not detect a difference in the frequency of monocytes

(CD11b+Ly6ChiLy6Glo) in thePex2�/� liver immune compartment

(Figures 3A–3D).
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Figure 3. Flow cytometry analyses of hepatic immune populations show developmental defects in hepatic myeloid and lymphoid immune

cells

(A) Measurement of hepatic neutrophils (CD11b+Ly6CintLy6Ghi), immature myeloid cells (GMPs) (CD11b+Ly6CintLy6Gint), and classical monocytes

(CD11b+Ly6ChiLy6G�) in livers of WT and Pex2�/� mice at neonatal day 0.

(B–D) Quantification of (B) hepatic GMPs, (C) neutrophils, and (D) monocytes in WT and Pex2�/� mice.

(E) Identification of hepatic DCs (CD45+ CD11c+ F4/80� Ly6G�), CD103+ DCs, and CD103� DCs in neonatal P0 mouse livers of WT and Pex2�/� mice.

(legend continued on next page)
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Analysis of the neonatal liver DC population of WT or Pex2�/�

mice showed similar proportions of total DCs (F4/80� CD11c+)

between each genotype, as well as a similar proportion of

CD103+ and CD103� DC subsets (Figures 3E and 3F). Given

the observed downregulation of MHC class II genes in the DC

population identified in our scRNA-seq data (Tables S3 and

S5), we measured the surface expression of MHC class II in

DCs and observed a significantly lower level of MHC class II

on the surface of DCs of Pex2�/� mice compared to DCs of their

WT littermates (Figure 3G).

To examine whether Pex2�/� had any detectable differences

in the developing hepatic B cell population of postnatal day

0mice, we stainedCD45+ liver immune cells for the B cell surface

marker CD19. Among liver B cells at postnatal day 0 in either WT

or Pex2�/� mice, we found that immature B cells (CD45loCD19+)

make up the majority of B cells, while only a few mature B cells

(CD45hiCD19+) are detectable at this age (Figure 3H). We de-

tected fewer immature B cells in Pex2�/� mice (Figures 3H and

3I) but no change in mature B cells (Figures 3H and 3J). Given

the significant changes in DC MHC class II expression, we

measured the cell surface expression of MHC class II on either

immature or mature B cells. No significant differences in the level

of MHC class II on B cells of WT or Pex2�/� littermates were de-

tected, although the proportion of MHC class II+ B cells trended

lower in each replicate (Figures 3K and 3L). Our flow cytometry

analysis of the neonatal immune populations of Pex2�/� mouse

liver reveals a consistent accumulation of immature or progenitor

populations for monocytes, neutrophils, and DC lineages, indi-

cating a possible developmental arrest/delay in these cells.

cDCs of Pex2�/� mouse display defects in MHC class II
expression
The identification of a significant downregulation of genes en-

coding the MHC class II protein complex in Pex2�/� DCs in the

scRNA-seq analysis and lower MHC class II surface expression

on Pex2�/� DCs in the flow cytometry analysis (Figures 2B, 2D,

and 3G; Tables S3 and S6) suggested that peroxisome function

might affect the antigen-presenting activity of these cells. To

identify the functional processes affected in Pex2�/� DCs, we

performed GSEAs on the differentially expressed genes identi-

fied between WT and Pex2�/� DCs. Genes with downregulated

expression in Pex2�/� DCs were enriched in processes associ-

ated with antigen processing and presentation, including the

MHC class I and II protein complexes, components of the Golgi

membrane, the lysosome, and the plasma membrane among

gene sets of cellular components queried, while COPI vesicles,

which are involved in Golgi-to-endoplasmic reticulum retrograde

trafficking of MHC protein complexes, were associated with

genes with upregulated expression in Pex2�/� DCs (Figure 4A).

Among biological processes queried, we found that genes with

downregulated expression in Pex2�/� DCs were associated

with myeloid leukocyte differentiation, long-chain fatty acid

metabolism, and inflammatory responses to antigenic stimulus

(Figure 4B). Conversely, we identified an enrichment of genes

with upregulated expression in Pex2�/� DCs associated with

negative regulators of lipid metabolism and glycerolipid catabo-

lism (Figure 4B). Given these observations and the data reported

above, we decided to investigate the antigen presentation activ-

ities in cDCs further.

As the population of cDCs in a liver at day 0 is very small, it

would have been complex and ethically challenging to dissect

the antigen presentation signaling in hepatic Pex2�/� compared

to that in WT cDCs. We planned to isolate CD45+ circulating im-

mune cells in peripheral blood to probe the hematopoiesis effi-

ciency of liver and bone marrow-derived cDCs from day

0mice and study the peroxisome requirement in antigen presen-

tation. However, the extraction of immune cells from the periph-

eral blood of the Pex2�/� mouse on day 0 yielded a meager cell

count incompatible with the experimental requirements (Fig-

ure S4D). Furthermore, due to the high penetrance and expres-

sivity of the lethality phenotype in the murine Pex2�/� PBD-

ZSS model, we could not conduct the analyses on peripheral

blood at a later age to obtainmore cells from the blood. For these

reasons, we studied the antigen presentation requirements for

peroxisomes using bone marrow-derived DCs (BMDCs) from

Pex2�/� and WT day 0 mice in cellulo.

Flow cytometry analyses confirmed that in-vitro-differentiated

BMDCs express the canonic markers for cDCs (Figure 4C). To

assess antigen presentation upon immune activation in Pex2�/�

BMDCs, we measured the surface expression of CD8a, CD11c,

the co-stimulatory molecules ICAM1 and CD80, and the class I

and II MHC protein complexes in WT and Pex2�/� BMDCs at

baseline and upon stimulation with lipopolysaccharides (LPSs).

We did not detect surface expression of CD8a onWT or Pex2�/�

BMDCs under any condition. The differentiation marker CD11c

was highly expressed on BMDCs from WT and Pex2�/� and

did not change with LPS treatment (Figure 4C). We observed

an upregulation of the co-stimulatory markers ICAM1 and

CD80 in LPS-stimulated Pex2�/� BMDCs versus WT cells; how-

ever, we found that the surface expression of MHC class I and II

protein complexes was significantly lower in Pex2�/� BMDCs in

both unstimulated and LPS-stimulated conditions (Figure 4C).

Since the flow cytometry analyses carried out in BMDCs corrob-

orate the results of the scRNA-seq, which showed a low expres-

sion of MHC class II genes in hepatic DCs of Pex2�/� mice, we

performed reverse-transcription quantitative polymerase chain

reaction (RT-qPCR) experiments to measure the expression of

the genes encoding the class II MHC protein complex, H2-Aa,

H2-Ab, and H2-DMb. We recorded lower expression for H2-

Aa, H2-Ab, and H2-DMb transcripts in Pex2�/� compared to

WT BMDCs (Figures 4D–4F), as observed in the hepatic cDCs

(Table S5). Upon LPS stimulation, the H2-Aa, H2-Ab, and

(F) Quantification of hepatic DC subsets.

(G) Measurement and quantification of surface MHC class II expression on CD103+ DCs.

(H) Identification of mature B cells (CD45hi CD19+) and immature B cells (CD45lo CD19+) in P0 neonatal mouse livers of WT and Pex2�/� mice.

(I–L) Quantification of (I) immature and (J) mature B cells and (K and L) their respective surface expression of MHC class II. A connecting line indicates littermates.

Significance determined by paired t test with p values for each comparison are shown. n = 5–8 independent experiments.

See Figure S4.
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H2-DMb transcripts were remarkably upregulated over 3 h of

treatment. However, no significant induction was observed in

stimulated Pex2�/� BMDCs (Figures 4D–4F). H2-Aa, H2-Ab,

and H2-DMb are transcribed by the transcription factor MHC

class II transactivator (CIITA)43; we found that the CIITA tran-

script is downregulated in Pex2�/� versus WT BMDCs in both

unstimulated and LPS-stimulated cells (Figure 4G). These results

demonstrate that BMDCs from Pex2�/� murine model mice can

differentiate into mature cDCs expressing canonical markers of

differentiation. However, as observed in the hepatic cDCs, these

cells exhibit deregulation of MHC class II genes, suggesting that

this is not caused by developmental and growth delays of

Pex2�/� animals. Of note, the upregulation of co-stimulatory fac-

tors was observed in the CIITA mutant murine model,43 indi-

cating that the upregulation of co-stimulatory factors might be

a compensatory mechanism.

PKC activity is low in BMDCs of Pex2�/� mice
Peroxisome lipidmetabolism has been described as amodulator

of differentiation and/or activation signaling in iNKT cells,44 mac-

rophages,11,12,14 mast cells,15 T cells, and B cells.16 CIITA is

regulated at the transcriptional and posttranscriptional levels

by activating Protein kinase C delat (PKC-d).45–47 PKC isoforms

comprise a family of lipid-activated enzymes, and PKC-d is one

of the PKC isoforms highly expressed in DCs and specifically

involved in the regulation of MHC class II expression.47 We

measured the activity of PKC-d in WT and Pex2�/� BMDCs un-

der unstimulated conditions and upon stimulation with LPS.

PKC activity increased in WT BMDCs after 3 h of stimulation

but not in Pex2�/� BMDCs (Figure 5A). PKC-d is denoted as a

novel PKC isoform48 and is activated exclusively by mem-

brane-bound diacylglycerols (DAGs) or phorbol 12-myristate

13-acetate (PMA), both of which anchor PKCs in their active con-

formations to membranes.49 We measured PKC-d activity in WT

and Pex2�/� BMDCs treated with PMA, which mimics DAGs,

and observed that PMA alone is sufficient to promote strong

activation of PKC-d. Our results show that PKC activity increases

in both WT and Pex2�/� BMDCs treated with both PMA and LPS

(Figure 5A), suggesting that peroxisomes control PKC activity in

LPS-stimulated BMDCs. In previous work, we showed that

peroxisome-depleted macrophages accumulate DAG species

mainly with unsaturated VLCFAs (RC22) while exhibiting reduc-

tion of DAG with saturated and unsaturated long-chain fatty

acids, and these differences were enhanced during the immune

challenge.12 Moreover, our functional annotation of differentially

regulated genes in pseudo-bulk analyses from the scRNA-seq

showed that genes belonging to glycerolipid (e.g., DAG) meta-

bolic processes were differentially enriched in Pex2�/� versus

WT liver immune cells. We assessed the expression of enzymes

involved in DAG metabolism and observed that genes required

for DAG synthesis such as Lpin1, Lpin2, and Pnpla2, which pro-

duce DAGs from phosphatidic acids (PAs) and triacylglycerides,

respectively, were downregulated in cDC1 Pex2�/� versus WT

(Figure S2E). On the other hand, genes that encode DAG kinases

and CDP-choline diacylglycerol choline phosphotransferases

that can transform DAGs into PAs and phosphatidylcholines,

respectively, were downregulated or unchanged in Pex2�/�

versus WT (Figure S2E). These transcriptional analyses suggest

that DAG metabolism might be altered in Pex2�/� versus WT

cDC1s. Thus, we measured the cellular concentration of DAGs

in WT and Pex2�/� in mock- or LPS-treated BMDCs. Pex2�/�

BMDCs have lower DAG concentrations in mock-treated and

LPS-treated conditions (Figure 5B). Considering that PKC-d is

the major DAG inducible isoform in murine DCs,47 our data sug-

gest that Pex2�/�BMDCs do not have the required amount/spe-

cies of DAGs upon LPS stimulation necessary to trigger PKC-

d-mediated signaling.

PKC-d activation is required to restore MHC class II
expression in Pex2�/� BMDCs
To further establish a requirement for PKC-d activation in

DCs upon LPS stimulation, we measured the activation of

PKC-d by both indirect immunofluorescence and western blot-

ting experiments. The activation of PKC-d is controlled by DAG-

mediated recruitment of the kinase to the plasma membrane

followed by autophosphorylation of serine 643 of PKC-d.50

We used an antibody specific to the phosphorylated serine

643 residue of PKC-d to measure the amount of phosphory-

lated PKC-d (P-PKC-d) in WT and Pex2�/� BMDCs by indirect

immunofluorescence. Our data showed a higher cellular

amount of P-PKC-d in LPS-stimulated and unstimulated WT

BMDCs compared to Pex2�/� BMDCs (Figures 5C and 5D).

We treated WT and Pex2�/� BMDCs with PMA and observed

that both WT BMDCs and Pex2�/� BMDCs showed an elevated

cellular amount of P-PKC-d (Figures 5C and 5D). We confirmed

these results by western blot, which showed that P-PKC-d in-

creases in WT BMDCs upon 3 h of LPS stimulation or treatment

with PMA followed by LPS stimulation (Figures 5E and 5F).

In Pex2�/� BMDCs, P-PKC-d levels did not increase after 3 h

of LPS stimulation but dramatically increased upon treatment

with PMA followed by LPS stimulation (Figures 5E and 5F).

Measurement of PKC-d and a-tubulin protein levels as loading

controls showed that the amounts of these proteins did

not change upon any treatment of WT BMDCs, while the

amount of PKC-d in Pex2�/� BMDCs treated with PMA and

LPS was lower (Figures 5E–5G). Despite this decrease in

Figure 4. Pex2 is required for the induction of MHC class II genes

(A and B) Select GSEA of differentially expressed genes in Pex2�/� versus WT hepatic DCs that were significantly enriched in functional categories of (A) cellular

components and (B) biological processes that impact the core activity of DCs.

(C) Flow cytometry analyses measuring cDC differentiation markers on a positive control cDC line versus isotype controls (top) on in-vitro-differentiated WT and

Pex2�/� BMDCs in response to mock treatment or LPS treatment (bottom).

(D–G) Violin and dot plots showing RT-qPCRmeasurements of (D) H2-Aa, (E) H2-Ab, (F) H2-DMb1, and (G) CIITA transcript relative expression versus the internal

control transcript Hprt in mock-treated and LPS-treated BMDCs over time.

n = 3 independent experiments. Statistical significance was calculated by two-way ANOVA test, ****p < 0.0001,***p < 0.001, *p < 0.05, ns not significant.

See Figures S2 and S3 and Tables S3, S4, S5, and S6.
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PKC-d in Pex2�/� BMDCs, these cells are able to achieve

similar levels of PKC-d phosphorylation to WT in BMDCs in

response to PMA, indicating that PMA is sufficient to activate

PKC-d to levels detected in WT and rescue DC responsiveness

to LPS.

Since PKC-d activation can regulate the expression of CIITA

and MHC class II genes,45–47 we tested whether CIITA and

MHC class II gene expression is modulated by the activation of

PKC-d induced by PMA or by the DAG analog 1,2-dioctanoyl-

sn-glycerol, a 1,2-diacyl-sn-glycerol, where both the 1- and

A B C D

E
F G

H I J

Figure 5. Pex2 regulates DAG-PKC-d signaling to activate CIITA and MHC class II in BMDCs

(A) Violin plots showing relative PKC activity in the BMDCs of the reported genotypes and under the indicated treatments.

(B) Violin plots showing concentrations of DAG in BMDCs of the reported genotypes.

(C) Indirect immunofluorescence indicating P-PKC-d in WT and Pex2�/� BMDCs treated with vehicle, LPS, or PMA plus LPS. Scale bar: 10 mm.

(D) Dot plot quantification of P-PKC-d in the indirect immunofluorescence experiments represented in (C). n = 20 cells.

(E) Representative western blot image to detect P-PKC-d and PKC-d in WT and Pex2�/�BMDCs treated with vehicle, LPS, or PMA plus LPS. a-Tubulin is used as

a loading control.

(F) The bar graph represents ratiometric analyses of the mean intensity value between P-PKC-d and PKC-d in western blot experiments. n = 3 independent

experiments.

(G) The bar graph represents ratiometric analyses of the mean intensity value between PKC-d and a-tubulin in western blot experiments. n = 3 independent

experiments.

(H–J) Dot and violin plots representing the expression of (H) CIITA, (I) H2-Aa, and (J) H2-Ab transcripts relative to the expression of Hprt transcript used as an

internal control in WT and Pex2�/� BMDCs treated with vehicle, LPS, PMA plus LPS, DAG plus LPS, or IFNg plus LPS.

n = 3 in (A), (B), (F), and (G) and 6 independent experiments in (H)–(J). Statistical significance was calculated by two-way ANOVA test, ****p < 0.0001,

***p < 0.001,**p < 0.01, *p < 0.05, ns not significant.
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2-acyl groups are specified as octanoyl fatty acid chains, which

are endpoints of b-oxidation in peroxisomes.51 This DAG is a

cell-permeable analog of the PKC-activating second-messenger

DAG.52,53 DAG treatment of Pex2�/� BMDCs rescues Ciita, H2-

Aa, andH2-Ab transcription (Figures 5H–5J). We observed upre-

gulation of the CIITA transcript in WT BMDCs treated with either

LPS, LPS plus PMA, or LPS plus DAG compared to mock-

treated BMDCs (Figure 5H). On the other hand, CIITA transcript

levels were not induced inPex2�/�BMDCs upon LPS stimulation

but were upregulated upon treatment with LPS and PMA and

with LPS and DAG, suggesting that activation of PKC-d is

required for the transcriptional induction of Ciita (Figure 5H).

We then measured H2-Aa and H2-Ab induction in WT and

Pex2�/� BMDCs during stimulation with LPS, LPS plus PMA,

or LPS plus DAG. Our RT-qPCR results indicate thatH2-Aa tran-

scription is enhanced in WT cells upon each stimulation, while

only LPS plus PMA and LPS plus DAG treatments were sufficient

to induceH2-Aa transcription in Pex2�/�BMDCs (Figure 5I). LPS

treatment alone did not induce H2-Aa expression in Pex2�/�

BMDCs (Figure 5I). Measurement ofH2-Ab transcription showed

an increase inWTBMDCsupon LPSor LPSplus PMA (Figure 5J);

however, as with Ciita and H2-Aa, the expression of H2-Ab was

not induced in LPS-treated Pex2�/� BMDCs, but treatment with

the PKC-d activator PMA or DAG rescued the LPS-stimulated

H2-Ab induction in the mutant BMDCs (Figure 5J).

Interferon-g (IFNg) can induceCiita gene expression and, there-

fore, MHC class II encoding genes in macrophages, DCs, and B

cells.45,54–56 PKC-d is crucial in regulating IFNg-mediated regula-

tion of CIITA gene expression.45 We measured the transcriptional

expression ofCiita,H2-Aa, andH2-Ab inWTandPex2�/�BMDCs

after 12 h of treatment with IFNg. Using RT-qPCR analyses, we

detected the induction of Ciita and H2-Aa in WT BMDCs

after IFNg treatment (Figures 5H–5J). Ciita and H2-Aa were

not transcriptionally induced in IFNg-treated Pex2�/� BMDCs

(Figures 5H–5J). However, we could not detect the induction of

H2-Ab either inWT orPex2�/� BMDCs in our experimental condi-

tions. These data suggested that IFNg-mediated induction ofCiita

and H2-Aa requires functional peroxisomes.

We confirmed the requirement of peroxisome metabolism for

CIITA expression at protein levels by performing indirect immu-

nofluorescence and western blot experiments using an anti-

CIITA antibody. Indirect immunofluorescence experiments

showed that CIITA increases in both the cytoplasm and nucleus

of BMDCs after a 3 h stimulation with LPS. It is exclusively nu-

clear in BMDCs pre-treated with PMA and then stimulated with

LPS (Figures 6A and 6B). In Pex2�/� BMDCs, CIITA was less

detectable in both the cytoplasm and nucleus but was present

in the nuclei of Pex2�/� BMDCs pre-treated with PMA and stim-

ulated for 3 h with LPS, confirming that PMA can trigger the

expression/stability of CIITA (Figure 6A). Western blot analyses

confirmed that CIITA is less in Pex2�/� BMDCs than in WT

BMDCs (Figures 7A and 7B), but PMA increased the cellular

amount of CIITA to the levels present in WT BMDCs

(Figures 7A and 7B). We concluded that peroxisomes are

required for the PKC-d-mediated induction of Ciita and of

H2-Aa and H2-Ab in BMDCs, in unstimulated conditions, and

upon stimulation with LPS or IFNg.

Peroxisomes regulate MHC class II expression and
antigen presentation to T cells
Flow cytometry experiments indicate that surface MHC

class II is lower in differentiated Pex2�/� BMDCs than in WT

A B

Figure 6. Pex2 regulates CIITA cellular amount and localization

(A) Indirect immunofluorescence indicating CIITA in WT and Pex2�/� BMDCs treated with vehicle, LPS, or PMA plus LPS. Scale bar: 10 mm.

(B) Dot plot quantification of CIITA/DAPI ratiometric fluorescence intensity values in the indirect immunofluorescence experiments represented in (A).

n = 20 cells. Statistical significance was calculated by two-way ANOVA test, ****p < 0.0001, **p < 0.01, *p < 0.05, ns not significant.
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Figure 7. Activation of PKC-d in WT and Pex2�/� BMDCs rescues MHC class II exposure and antigen presentation to CD4+ T cells

(A) Representative western blot image to detect CIITA in WT and Pex2�/� BMDCs treated with vehicle or PMA. a-Tubulin is used as a loading control.

(B) The bar graph represents ratiometric analyses of the mean intensity value between CIITA and a-tubulin in western blot experiments. n = 3 independent

experiments.

(C) Dot plot quantification of MHC class II in the indirect immunofluorescence experiments represented in (D). n = 10 cells.

(D) Representative indirect immunofluorescence images indicatingMHC class II inWT and Pex2�/�BMDCs treated with vehicle, LPS, LPS plus PMA, or LPS plus

DAG. Scale bar: 10 mm.

(E) The diagrams represented cytosolic calcium fluxes in time-lapse movies.

(F) Dot plot quantification of the fluorescence amplitude of the calcium fluxes recorded in CD4+ T cells co-cultured with WT and Pex2�/� incubated with OVA and

stimulated with LPS or PMA plus LPS. n= 25 cells.

(G) Dot plots of total cell count of lymphocytes, neutrophils, and monocytes in the peripheral blood. n = 14.

Statistical significance in (A)–(C) and (F) was calculated by two-way ANOVA test, and statistical significance in (G) was calculated by unpaired t test, ****p < 0.0001,

***p < 0.001, **p < 0.01, *p < 0.05, ns not significant.
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BMDCs (Figures 3, 4C, and S5A). However, PMA treatments

remarkably enhanced the MHC class II surface signal in WT

and Pex2�/� BMDCs (Figure S5A). We performed indirect immu-

nofluorescence using the same antibody and observed high

MHC class II in WT BMDCs unstimulated and stimulated with

LPS for 3 h. Conversely, the MHC class II signal was very low

or absent from the cell surface in Pex2�/� BMDCs in both unsti-

mulated and stimulated conditions (Figures 7C and 7D). Treat-

ment with PMA or DAG followed by stimulation with LPS rescued

MHC class II expression and surface exposure in Pex2�/�

BMDCs to WT levels and higher (Figures 7C, 7D, and S5A).

The inability to expose MHC class II can impact the efficiency

of antigen presentation to activate T cells. Therefore, we per-

formed a calcium antigen presentation assay to probe antigen

presentation in WT and Pex2�/� BMDCs.57

Differentiated BMDCs from both genotypes were stimulated

overnight with or without LPS and then incubated for 3 h with

0.5 mM chicken ovalbumin (OVA) 323-339 peptide that binds

to the I-A MHC class II in the presence of LPS and PMA. Under

each condition, WT and Pex2�/�BMDCswere washed and incu-

bated with CD4+ T cells isolated from transgenic mice express-

ing the OVA-specific I-Ab-restricted TCR (OT-II). We performed

calcium imaging of OT-II CD4+ T cells in co-culture and moni-

tored antigen-specific calcium signaling as an indication of

T cell activation. We found that OT-II CD4+ released more

intense calcium signaling when incubated withWT BMDCs stim-

ulated with LPS compared to unstimulated WT BMDCs or to un-

stimulated and stimulated Pex2�/� BMDCs (Figures 7E and 7F).

Pex2�/� BMDCs stimulated with LPS can trigger a modest cal-

cium signaling in OT-II CD4+ T cells (Figures 7E and 7F), but it

is significantly lower than what we observed in stimulated WT

BMDCs, suggesting that Pex2�/� BMDCs had reduced antigen

presentation activity (Figures 7E and 7F). PMA treatment of

Pex2�/� BMDCs fully rescued the antigen presentation activity

to OT-II CD4+ T cells of Pex2�/� BMDCs (Figures 7E and 7F).

In parallel, we analyzed the expression level of the DC differenti-

ation marker CD11c by flow cytometry, and we observed that

differentiation was not affected by PMA treatments in both WT

and Pex2�/� BMDCs (Figure S5A). We therefore concluded

that peroxisomes are required to modulate DAG signaling at

the plasma membrane and to activate pathways that promote

antigen uptake, exposure of MHC class II, and antigen presenta-

tion activity to CD4+ T cells in DCs. Differentiation of cDCs in the

hepatic environment of Pex2�/� mice is compromised or de-

layed. Interestingly, BMDCs from Pex2�/� mice can differentiate

in vitro tomature DCs, but theMHC class II expression is lower in

Pex2�/�BMDCs than inWT cells, as observed in Pex2�/� hepat-

ic cDCs. The MHC class II expression can be rescued by phar-

macological activation of PKC-d, which is sufficient to restore

the antigen presentation activity of Pex2�/�BMDC to CD4+ DCs.

Antigen presentation activity to CD4+ T cells is not
affected in Pex2�/� macrophages
To understand if peroxisome function is a general requirement

for antigen presentation activity, we tested if other antigen-pre-

senting cells in Pex2�/� mice exhibited similar defects in antigen

presentation. We assessed antigen presentation by BMDMs

from Pex2�/� mice alongside BMDCs. We performed calcium

imaging upon co-culture with OT-II CD4+ T cells and monitored

antigen-specific calcium signaling to indicate T cell activation.

We found that OT-II CD4+ T cells released more intense calcium

signaling when incubatedwithWTBMDCs compared to Pex2�/�

BMDCs regardless of prior LPS stimulation (Figures S5B). We

could also detect calcium signaling when OT-II CD4+ T cells

were incubated with WT or Pex2�/� BMDMs; however, we did

not record significant differences when OT-II CD4+ T cells were

incubated with WT or Pex2�/� BMDMs, suggesting that peroxi-

some function is not required for macrophage antigen presenta-

tion (Figure S5B).

We performed RT-qPCR to measure CIITA and H2-Aa tran-

scripts. CIITA and H2-Aa transcripts were significantly lower in

Pex2�/� BMDMs than in WT when cells were not stimulated

with LPS (Figures S5C and S5D). When BMDMswere stimulated

for 3 h with LPS, we did not record differences in the CIITA tran-

script level (Figure S5C). The H2-Aa transcript was lower in

Pex2�/�BMDMs relative to stimulatedWTBMDMs (Figure S5D);

however, the difference was not as striking as the one observed

between WT and Pex2�/� BMDCs. We concluded that Pex2 is

partially required to express MHC class II encoding gene H2A-

a in BMDMs.

To determine if the observed decrease in antigen presentation

was in part a result of reduced antigen uptake, we also tested the

uptake rate of OVA-Alexa Fluor 488 in WT and Pex2�/� BMDCs

and observed a very small but significant reduction in the uptake

of OVA-Alexa Fluor 488 in Pex2�/� BMDCs relative to WT

BMDCs, suggesting that Pex2�/� BMDCs have reduced phago-

cytosis (Figures S5E and S5F), an immune defect observed in

macrophages with a deficiency in peroxisome biogenesis,11,12

but not to the extent that they deplete MHC class II exposure

upon stimulation.

Hematopoietic defects are detected in the Pex2�/�

murine spleen and in the peripheral blood of patients
with PBD-ZSS
Weprobedwhether hematopoietic defects inPex2�/�micewere

detectable outside the liver. We probed the immune landscape

of neonatal spleen from WT and Pex2�/� mice. We performed

flow cytometry analyses on CD45+ cells and isolated neutrophils

(Lys6G), red pulp macrophages (F4/80), and B cells (CD19). We

found that Pex2�/� mice have fewer total splenic immune cells

thanWTmice (Figure S5G). Furthermore, when we selected spe-

cific myeloid and lymphoid populations, we found that red pulp

macrophages (F4/80+), neutrophils (Ly6g+), and B cells (CD19+)

were reduced in Pex2�/� spleen compared to the WT spleen

(Figures S5H–S5J). These data suggested that hematopoietic

defects are also detected in other tissues of the Pex2�/� mouse.

We then enquired whether children affected by PBD-ZSS

show a reduction in white blood cells at birth. We analyzed pe-

ripheral blood mononuclear cells of thirteen patients affected

by PBD-ZSS, each carrying defined mutations in different PEX

genes (six patients with mutation in Pex1, one patient in Pex26,

one in Pex5, four in Pex6, and one in Pex10) and one undefined.

All patients were between 0 and 1 month old (human age corre-

sponding to day 0 in mice) and were tested one or more times.

Therefore, we averaged the results obtained from the count of

the immune cells of each blood withdrawal. We observed that
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neutrophil and lymphocyte numbers were significantly low and

ranked close to the minimum value reported in healthy children

in the same age range (Figure 7G) for each cell type. The number

of monocytes in the patients was comparable to the low content

value reported in healthy children in the same age range. Howev-

er, the reduction was not statistically significant (Figure 7G). This

preliminary study in PBD-ZSS suggests that hematopoiesis

might be affected in patients with PBD-ZSS, at least in the first

months of life.

DISCUSSION

We defined the requirement for peroxisomes in developmental

hematopoiesis, demonstrating that severe PBD-ZSS presents

hematopoietic alteration in the neonatal liver.

The connection between peroxisome dysfunction and

impaired cellular development and survival is known.4,58 Our

characterization of the hepatic immune landscape of the

PBD-ZSS Pex2�/� mouse model suggests that the metabolic

dysfunctions that arise due to failed peroxisomal biogenesis

prompt differentiation defects in the immune system of children

with PBD-ZSS. In the past 30 years, few clinical cases have

described immune defects in specific immune cells in young

patients with PBD-ZSS that did not carry a mutation in genes

linked to immunodeficiences.5,6,59 Our study provides evidence

that peroxisomes are required to develop the immune system,

and in this view, the link between primary immunodeficiencies

and metabolic disorders should not be undervalued. Indeed,

as highlighted in a recent paper,7 many other metabolic dis-

eases are known to cause immunological defects: adenosine-

deaminase deficiency leads to severe combined immunodefi-

ciencies,60 and familial hemophagocytic lymphohistiocytosis

is caused by alterations in the molecular mechanisms involved

in vesicle transport and membrane trafficking processes.61

Additionally, in the past 10 years, multiple studies reported

that the peroxisome or its metabolites control various immune

cell functions and signaling in response to microbial challenges,

such as phagocytosis, TLR-mediated cytokine secretions,12,15

MAVS activation,13 NF-kB activity, and RhoGTPase sig-

naling.11,12 Alteration of these signaling processes has been

linked to the development of immune disorders.62–65 Consid-

ering all the above, and since the characterization of peroxi-

some diseases is incomplete, we firmly believe that immune

phenotyping should be performed for all patients with sus-

pected or proven peroxisome disorders to identify strategies

to ameliorate the status of PBD-ZSS. A case study reporting

the use of allogeneic hematopoietic stem cell transplantation

(allo-HSCT) to treat PEX1� PBD-ZSS found that allo-HSCT

was effective at lowering the VLCFA level in serum and allevi-

ating disease symptoms in the patient during the short-term

follow-up.66 Allo-HSCT has also been used to treat X-linked ad-

renoleukodystrophy (X-ALD). It has been shown to have good

long-term efficacy at improving survival rates in patients if

applied in the early stage of the disease. The long-term benefits

of allo-HSCT in X-ALD are thought to be mediated by donor-

derived replacement of myeloid-derived cells,67 supporting

the importance of detecting and addressing immune defects

in PBD-ZSS.

The liver at postnatal day 0 is a reservoir of cells at different

stages of development and pluripotency. This aligns with evi-

dence that the liver remains a central organ for immune cell matu-

ration after birth in rodents,19 as other sites of immune cell devel-

opment are aplastic during the first week of life, and that the

neonatal immune systemmay rely on alternative organs to finalize

maturation. The liver environment receives primary antigen inputs

from the gastrointestinal circulation.68,69 It could be a strategic site

to support newborn immune development, while bone marrow

and the spleen progressively replace this function. Analysis of

the splenic immune subsets in postnatal day 0 WT and Pex2�/�

miceby flowcytometry analyses uncovered severe hematopoietic

defects associated with Pex2 deficiency. These defects were

magnified among circulating populations. Although it was re-

ported that few Pex2�/� mice could survive at least at postnatal

day 10,21 in our hands, the mice died at postnatal days 0–1. We

speculate that the difference could be due to environmental differ-

ences caused by different animal houses.70 In our study, we could

differentiate in vitro cDCs ormacrophages frombonemarrowpre-

cursors of WT and Pex2�/� mice. However, the defects in the

expression of MHC class II expression in BMDCs, which is a

marker of differentiation, could not be rescued in vitro, suggesting

that some differentiation processes are permanently affected and

depend on peroxisome in a cell-autonomous way. Future studies

to investigate the requirement for peroxisomes in hematopoiesis

postbirth and at different hematopoietic sites should be conduct-

ed using conditional Pex2 deletion models.

The identification of a requirement for peroxisome lipid meta-

bolism in cDC expression of MHC class II has broad implications

for host immunity. We demonstrated the impact of this defect,

showing that antigen presentation activity by cDCs via MHC

class II to CD4+ T cells is impaired.

Our findings shed light on the immunemetabolic requirements

of peroxisomes in immune cells. Our data also have an implica-

tion for a better understanding of DC development and function.

Given the importance of DCs and their role in antigen presenta-

tion to T cells for vaccine efficacy, our study also enhances the

importance of considering the peroxisome as a potential phar-

macological target in future considerations for vaccine and adju-

vant designs. Additionally, our data also contribute to the tran-

scriptional signatures that identify neonatal hepatic immune

cells and detail pathological features of PBD-ZSS that help bet-

ter define this disease. These findings add to the growing list of

peroxisome immunomodulatory functions and confirm the major

role that peroxisomes play not only in innate immune cells but

also in adaptive immunity, underlining the potential for using

peroxisome function as markers or therapeutic targets in meta-

bolic and immune disorders.

Limitations of the study
This study provides transcriptional signatures to identify the im-

mune population at day 0 hepatic immune environment. A limita-

tion of this study is that we could not perform scRNA-seq

experiments after day 0, and therefore we could not record how

the cell-specific gene signatures change over time. Our study pro-

vides the analysis of hematopoiesis in a severe PBD-ZSS model.

Our data strongly suggest that severe defects in peroxisome

biogenesis affect developmental hematopoiesis. However, we
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studied a severe PBD-ZSSmurinemodel that is lethal at days 0–1

postbirth in our hands. This phenotype’s high penetrance and ex-

pressivity have been an obstacle to probing the hepatic immune

environment at a later age and verifying whether the immune

cell development is ultimately affected or only delayed. We found

that bone marrow-derived cells can differentiate in vitro into mac-

rophages12 and DCs. However, the bone marrow-derived cells

still present the differentiation defects observed in hepatic DCs,

suggesting that distinct differentiation defects are intrinsic and

are not caused by environment or developmental delay. A previ-

ous study reported that ablation of peroxisome functions only in

the hematopoietic stem cells led to developmental and functional

defects in innate B cell and T cell clonal expansion16 but did not

detect defects in follicular B or T cells. This discrepancy with our

data could be due to differences in the genemutation or temporal

and spatial activation of the mutation. Further studies in various

inducible and less severe global PBD-ZSS mice are necessary

to define the requirement of peroxisome in hematopoiesis.
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CD11c Biolegend 117305

CD19 Biolegend 152407

CD3e Biolegend 100327

NK1.1 Biolegend 156514
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CD11c PE-Cy7 Biolegend Clone N418

PKC-d CellSignaling D10E2

P-PKC-d CellSignaling Ser643/676

a-tubulin Sigma-Aldrich T5168

Ciita Thermo Fisher Scientific PA5-101105
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BD PBX Becton Dickinson 640175

OVA (257–264) Eurogentec (Anaspec) AS-60193-5

OVA (323–339) Invivogen Vac-isq
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Sigma L2880-25MG

PBS 10 X thermofisher 70011044
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Critical commercial assays

MiniMACSTM Separator and Starting Kit Miltenyi Biotec. Inc NA

NexteraXT tagmentation kit Illumina Inc FC-131-1024

surface-bound Alexa Fluor488-labelled OVA Invitrogen 11539176

Phorbol 12-myristate 13-acetate Sigma–Aldrich 524400

1,2-dioctanoyl-sn-glycerol Sigma–Aldrich 317505

RPMI, glutamax 1% Cytiva SH300096.01
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Trizol Thermo Fisher Scientific 15596018
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Direct-zolTM RNA MicroPrep (200 Preps)

w/Zymo-SpinTM IC Columns

Cedarlane R2062

PKC Kinase Activity Assay Kit Abcam AB139437

Diacylglycerol Assay Kit Abcam AB242293-1001

1 x Complete Protease Inhibitor Roche 11697498001

PhoStop Roche 4906837001

PowerTrack SYBR Green Master Mix Applied Biosystems A46109

High-Capacity cDNA Reverse Transcription

Kit with RNase Inhibitor

Applied Biosystems 4374966

PierceTM 16% Formaldehyde (w/v), Methanol-free Thermo Fisher Scientific 28906

Fetal bovine serum Thermo Fisher Scientific 10270106

Penicillin-Streptomycin Thermo Fisher Scientific 15140122

Deposited data

scRNA sequencing data This study GSE248598

Experimental models: Cell lines

Mouse: Bone marrow derived macrophages from

Sw129-Pxmp3tm1Plf�/�Mutant Mouse

Resource and MMRRC

Research Center (MMRRC) supported

by the NIH

Faust and Hatten, 199718

Mouse: Bone marrow derived dendritic

cells from Sw129-Pxmp3tm1Plf�/+

Research Center (MMRRC) supported

by the NIH

Faust and Hatten, 199718

MutuDC1 Gift from Yannick Hamon, CENTER

D’IMMUNOLOGIE

MARSEILLE

NA

Experimental models: Organisms/strains

129S6.129-Pex2tm1Plf/Mmmh Mutant Mouse Resource and

Research Center

Faust and Hatten, 199718

Swiss Webster Charles River 024

OT-II mouse JAX 003831
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Di Cara

Dalhousie University (This paper)

NA
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Di Cara

Dalhousie University (This paper)

NA

Ciita forward 50-CCCTGCGTGTGATGG

ATGTC-30
Di Cara

Dalhousie University (This paper)

NA

Ciita reverse 50-ATCTCAGACTGATCC

TGGCAT-30
Di Cara

Dalhousie University (This paper)

NA

H2-Aa forward 50-CAACCGTGACTATT

CCTTCC-30
Di Cara

Dalhousie University (This paper)

NA

H2-Aa reverse 50-CCACAGTCTCTGTC

AGCTC-30
Di Cara

Dalhousie University (This paper)

NA

H2-Ab1 forward 50-GTGTGCAGACACA

ACTACGAGG-30
Di Cara

Dalhousie University (This paper)

NA
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Di Cara

Dalhousie University (This paper)

NA
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Di Cara

Dalhousie University (This paper)

NA
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Di Cara

Dalhousie University (This paper)

NA
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RESOURCE AVAILABILITY

Lead contact
Further information and requests for resources and reagents should be directed to and will be fulfilled by the lead contact, Francesca

Di Cara (dicara@dal.ca).

Materials availability
No new reagent or animal model was generated in this study.

Data and code availability
d All sequencing data have been uploaded to the NCBI GEO database and can be accessed via the project accession number

GSE248598.

d This paper does not report original code

d Any additional information required to reanalyze the data reported in this paper is available from the lead contact upon request.

EXPERIMENTAL MODEL AND STUDY PARTICIPANT DETAILS

Mammalian cells
Murine bone marrow-derived macrophages

Murine bone marrow-derived monocytes were extracted from male and female 1-day-old pups, differentiated into macrophages

(BMDMs), and treated as previously described (Geng et al., 2015).

Murine bone marrow-derived dendritic cells

Bone marrow hematopoietic cell progenitors were differentiated into dendritic cells in RPMI, glutamax 1%, 10% Fetal calf serum,

penicillin/streptomycin (1%) supplemented with GM-CSF (# 315-03 PeproTech, 20 mg/ml) for three days following recovery at

37�C, 5%CO2. The culture mediumwas changed every two days. Cells were split before they reached 80% confluency at each pas-

sage. Cells were harvested using gentle non-enzymatic cell dissociation reagent (PBS 1X, EDTA 0.5mM) and pulled together with

cells in suspension. All cells were spun down and resuspended in a complete medium supplemented with 10 mg/ml GM-CSF for

five days, followed by a two days period where IL-4 (10mg/ml214-14 PreproTech) was added in addition to GM-CSF. Before flow

cytometry, bone marrow-derived dendritic cells (BMDC) were splatted and divided into two plates. Cells in one dish were treated

with the required stimuli.

Human peripheral blood mononuclear cells

Peripheral bloodmononuclear cells (PBMCs) from 0 to 6-month-old healthymales or female patients affected by PBD-ZSSwere pro-

vided by Dr. Nancy Braverman, McGill University (REB#). Frozen cell stocks were thawed and grown in RPMI medium (Gibco) sup-

plemented with 10% heat-inactivated fetal bovine serum (HI FBS) (Hyclone, Thermo Scientific), 2 mM L-glutamine (Gibco), 50 mM

2-mercaptoethanol, 50 U penicillin/mL, 50 mg streptomycin sulfate/mL.

Pex2 mutant mice

The Pex2 mutant mouse strain used was 129S6.129-Pex2tm1Plf/Mmmh (null allele).

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Software and algorithms

R version 4.0.4 https://www.r-project.org NA

Python 3.7 https://www.python.org McInnes et al., 202071

FIJI/ImageJ software https://imagej.nih.gov/ij/ Schneider et al., 201272

GraphPad 6 Prism NA

Cytoscape NA Reimand et al., 201973

Zeiss Zen lite Black & lite Blue Zeiss https://www.zeiss.com/microscopy/

int/products/microscope-

software/zen-lite.

FloJo BD NA

IDEAS software Millipore https://www.emdmillipore.com/CA/

en/20150212_144049

Others

observation chamber Labtek NA
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Faust and Hatten, 1997) were obtained from theMutantMouse Resource & Research Centers (MMRRC) supported by the National

Institutes of Health. The mice used for the experiments reported herein were Pex2+/+, Pex2�/�, and Pex2+/�. Homozygous null mu-

tants showed no Pex2 transcript and no Pex2 protein. Homozygous null mutants in the congenic strain 129S6.129-Pex2tm1Plf +/�

showed variable embryonic lethality, starting at �E11. Approximately 20% of homozygous null mutants survived to birth but were

hypotonic, did not feed, and died on the day of birth. Homozygous null mutant mice that survived into the postnatal period were ob-

tained by mating congenic 129S6.129-Pex2tm1Plf +/� mice with wild-type Swiss Webster strain mice. F1-Pxmp3tm1Plf +/� hybrids

(designated Sw129) were then intercrossed to obtain Sw129-Pxmp3tm1Plf �/� (indicated in the text as Pex2�/�) mice. Colonies

were maintained as stable inbred lines in the Swiss Webster and 129SVEV backgrounds under approved animal protocol #21–

023, abiding by the Canadian Council on Animal Care standards. The absence of peroxisomal matrix import in the homozygous

mutant of this mouse strain was previously confirmed by our group.12

Equal number of males and females mice were used in each experiment.

METHOD DETAILS

Reagents
Rabbit antibodies to PKC-d (D10E2) and P-PKC-d (Ser643/676) were from Cell Signaling.

The mouse antibody to a-tubulin (T5168) was from Sigma-Aldrich.

The mouse antibody to CIITA (PA5-101105) was from Thermo Fisher Scientific.

Alexa Fluor 488-conjugated, and Alexa Fluor 555-conjugated donkey anti-mouse or donkey anti-rabbit secondary antibodies were

from Abcam.

Phorbol 12-myristate 13-acetate (PMA)(#524400) and 1,2-dioctanoyl-sn-glycerol (#317505) were from Sigma–Aldrich and IFNg

(#575308) was from eBioscience.

Lipopolysaccharides from Escherichia coli O55:B5 (#L2880-25MG) were from Sigma-Aldrich. RPMI 1640 media was from Cytiva

(SH300096.01) and RPMI was supplemented with 1% GlutaMAX (Gibco; #35050061).

Treatment with phorbol 12-myristate 13-acetate, 1,2-dioctanoyl-sn-glycerol or IFNg of DCs
DifferentiatedWT and Pex2�/�BMDCs were incubated for 1 h with 25 ng/mL phorbol 12-myristate 13-acetate (PMA) (Sigma–Aldrich

#524400), 10 mM 1,2-dioctanoyl-sn-glycerol (Sigma–Aldrich #317505) or with 100 ng/mL IFNg (eBioscience #575,308) for 24 h and

stimulated with LPS 100 ng/mL in 3-h experiment at 37�C, BMDCs were harvested in Trizol for RNA extraction fixed in 4% formal-

dehyde for immunofluorescence experiments or collected in PBS 1X, EDTA 5mM non enzymatic treatment and further labeled for

flow cytometry.

Multi-spectral imaging flow cytometry (IFC)
To perform IFC, 1010 Alexa Fluor488-labelled -OVAII was added to 106 BMDCs and the combined cells were incubated for 15 min at

4�C to allow for Alexa Fluor488-labelled -OVA-cell contact and then incubated for 2 h at 37�C in Cell Culture Medium. DNA was de-

tected by staining with Hoechst 33342. Data were acquired on an ImageStream Imaging FlowCytometer (Amnis) (Rieger et al., 2010).

Cells were analyzed post hoc.

Internalization assay
The number of Alexa Fluor488-labelled BMDCs cells was determined for each population by comparing the percentage of cells with

internalized Alexa Fluor488-labelled OVA (Invitrogen #11539176) to the rate of cells with surface-bound Alexa Fluor488-labelled

OVA. Using IDEAS software (Millipore), a mask was created to identify the eukaryotic cell membrane using the bright field signal

for two sets of samples and cell tracker dye for two other groups of samples. This allowed differentiation between internalized (degree

of internalization greater than 0) and bound (degree of internalization less than 0) Alexa Fluor 488 particles in the x-y axes and on the

z axis.

Sample preparation for single-cell sequencing
Postnatal day-0 mice from three genotypes (Pex2�/�, Pex2Het, andWT) were euthanized by decapitation, their livers were excised and

passed through a 70 mmcell strainer (Falcon Cat#352350) into 1x HBSS using a 1mL syringe plunger. Liver cell suspensions were then

centrifugedat 20xg for 5min to removehepatocytes. The supernatantwas isolatedandACK lysiswasperformed to lyse redbloodcells.

The final cell suspensionwas resuspended in 1xPBS 0.5%BSA, cell countswere determined and cells surface-stained for flow cytom-

etry using a 1:50 dilution of FITC- and ef450-conjugated anti-CD45 antibodies and staining with a fixable viability dye (ThermoFisher

eBioscience Cat#65–0865). Viable CD45+ cells were sorted on a BD FACs ARIA II cell sorter. Sorted CD45+ cells were then processed

and fixed according to the 10XGenomics Flex Assay protocol. Fixed cells were counted and stored at�80�Cand shipped on dry ice to

the PrincessMargaret Genomics Center for generation of 10XGenomics barcoded libraries and sequencing. Cell count determined for

each genotype prior to sequencing were: 1.46x106 cells from WT, 1.45 and 3.06x105 from Pex2�/� mice, and 1.3 and 3.93 x105 from

Pex2Het mice. Samples were sequenced on an NovaSeq X Plus at a median sequencing depth of 50,000 reads per cell. Sequences

were mapped to the mouse (mm10) genome using the cell ranger multi pipeline in Cell Ranger v.7.0.0.
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Single-cell RNA sequencing analysis

Analysis of single-cell transcriptome gene expressionwas performed using 10xGenomics LoupeBrowser v7.0. Low-quality cells and

genes were filtered for downstream analysis. Analysis of single-cell transcriptome gene expression was performed using 10x Geno-

mics Loupe Browser v7.0. Low-quality cells and genes were filtered for downstream analysis. We performed stringent filtering to

ensure only high-quality data were retained for downstream analysis. We excluded cells expressing less than 700 genes across

all conditions as well as those with high mitochondrial count (cutoff off 10%). Duplicate cells were also eliminated by maintaining

an upper gene count cut off of (8000 counts). Consequently, a total of 34,895 cells passed this filtering criterion equating 95.3%

rate or retention. We then performed dimensionality reduction and unsupervised clustering using UMAP. Cluster identification

was guided using a K-Means of 10 clusters. Based on these clusters cell types were assignedmanually following significant literature

evaluation of cluster marker genes.19,20 Subpopulations within each cell type (e.g., distinction of cDC1, cDC2, pDC, andMDP as sub-

populations of DCs) were defined by first segregating each cell type cluster from the total cell population and then re-clustering to

identify additional subclusters. Differential expression analysis was performed between assigned cell type clusters where a subset

of 5–10 of the top differentially expressed genes (DEGs) and established cell type markers defined each cell type cluster. The log2

fold-change values of selected DEGs and cell assignments were hierarchically clustered and visualized by heatmap (Morpheus,

https://software.broadinstitute.org/morpheus). To identify DEGs between WT, HET and KO samples, a pseudo-bulk differential

expression analysis was performed using Loupe Browser 7.0.0. In brief, DEGs with >1.5 log-fold change between cell types of

each genotype were assessed.

Single-cell enrichment pathway

Gene Set Enrichment Analysis (GSEA) was performed using GSEA v4.1.0 to identify biological processes, cellular components, and

KEGG pathways significantly altered in the hepatic immune cells of Pex2�/� mice versus WT mice. The gene interaction network of

GSEA results was generated and manually curated to remove redundant and uninformative nodes using Cytoscape v3.8.2.73

Flow cytometry
Postnatal day-0 mice were euthanized by decapitation, their livers were excised and passed through a 70 mm cell strainer (Falcon

Cat#352350) into 1x HBSS using a 1 mL syringe plunger. Liver cell suspensions were then centrifuged at 20 xg for 5 min to remove

hepatocytes. The supernatant was isolated and ACK lysis was performed to lyse red blood cells. The final cell suspension was re-

suspended in 1x PBS, cell counts were determined and then surface-stained for flow cytometry. Single-cell suspensions were

stained with antibodies and stains listed. After gating out doublets CD45+ and fixable viability dye negative cells (ThermoFisher eBio-

science Cat#65–0865) were gated by to their respective immune cell types as indicated. All samples were acquired on a BD-LSR

Fortessa cytometer. For staining of bone marrow-derived cells for flow cytometry, cells were collected by 1x PBS, 5 mM EDTA

nonenzymatic treatment. Cells were first surface stained for 45 min on ice with antibodies, washed twice in 1x PBS and further

analyzed by flow cytometry on a FACSymphony cell analyzer (Becton Dickinson). Post-acquisition, after gating out doublets and

cell debris, cells were reported in Figure S4.

Antigen presentation assay
OT-II CD4+ T cell cytosolic calcium fluxes were measured according to the ‘‘methods for automated and accurate analysis of cell

signals’’ (MAAACS) developed by the co-author Dr. Hamon and extensively described in.57 In brief, according to the manufacturer’s

instructions, T cells were loaded with PBX calcium reporter (BD) diluted in 1X dye loading solution at 37�C for 1 h in the dark. Next,

cells were washed twice by gentle centrifugation and resuspended in Hank’s balanced salt solution buffered with HEPES (1mM)

(HBSS-H). They were then introduced in the desired observation chamber (Labtek) where BMDC or MutuDC1 were previously

seeded 2 two days prior experiment and ON loaded with various OVA concentrations). Analysis was performed on a Zeiss LSM

780 confocal microscope equipped with a C-Apochromat 40X/1.2 water immersion objective and an argon laser with a 488 nm

dichroic and a 505–530 nm band-pass filter. A temperature control system was used to ensure that 37�C was maintained during

the entire acquisition. Time-lapse movies were typically made of 600 images taken every 7 s (with a pinhole set to 4 airy units), while

cells were kept at 37�C using a hot plate.

RNA extraction and quantitative real-time PCR
Cells were rinsed twice with PBS, transferred to TRIzol reagent, and snap-frozen in liquid nitrogen. Total RNAwas extracted using the

Direct-Zol RNA micro prep (Cedarlane), according to the supplied protocol. RNA was reverse transcribed using 1) the High-capacity

cDNA reverse transcription Kit (Applied Biosystems), and the synthesized cDNA was used for qPCR using the Power Track SYBR-

Green PCRmaster mix (Applied Biosystems) and a QuantStudio 6 Flex Real-Time PCR system (Applied Biosystems). Samples were

normalized to Hprt gene expression for mouse experiments using the relative quantification methods and primer efficiency. Primer

sequences used in real-time qPCR are presented in the Key resources table.

Isolation of cell membranes
Cells were isolated in 0.25 M STKM buffer (0.25 M sucrose, 25 mMHEPES-KOH, pH 7.4, 25 mM KOAc, 5 mMMgCl2, 0.1 mM EDTA,

1 x Complete Protease Inhibitor (Roche), 1 mM DTT) and sonicated in a sonicator bath to yield lysates. Lysates were centrifuged at

1,000 x g for 10 min at 4�C. The supernatant from this first spin was centrifuged at 10,000 x g for 20 min at 4�C. The supernatant from
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this second spin containing fragmented membranes was centrifuged at 100,000 x g at 4�C for 1 h. The resultant pellets were resus-

pended in 0.25 M STKM and used for lipid assay.

Quantification of diacylglycerol
Diacylglycerol quantification was done using the Diacylglycerol Assay Kit (Abcam AB242293-1001) following the manufacturer’s

protocol.

Lipid amounts were normalized to cell number and protein amount.

PKC kinase activity assay
PKCkinase activity wasmeasured using the PKCKinase Activity Assay Kit (AbcamAB139437) following themanufacturer’s protocol.

Kinase activity was normalized to cell number and protein amount.

Immunofluorescence microscopy
Cells were fixed in 4%paraformaldehyde in PBS for 30min, then incubated for 1 h at room temperature in 5%normal goat serum in 1x

PBS and for 16 h at 4�C with primary antibody at a 1:100 dilution in 5% normal goat serum in 1x PBS. Appropriate Alexa Fluor sec-

ondary antibodies were then used at 1:1000 dilution in 5% normal goat serum, while Cy5 fluorescently labeled phalloidin was added

to stain the cytoskeleton. After 4 washes in PBST (PBS +0.1% (v/v) Triton X-100), cells were mounted in DAPI Pro-Gold Antifade Re-

agent (Thermo Fisher) and imaged using a 63x oil immersion objective (NA = 1.4) using a Zeiss AxioObserver LSM 880 Airyscan, 63x

1.4 oil plan-Apochromat lens.

Preparation of protein extracts for SDS–PAGE
Cold lysis buffer (70 mL) (Ephrussi-Beadle Ringer’s solution containing 10mMEDTA, 10mMdithiothreitol (DTT), and Roche complete

protease and phosphatase inhibitors) was added to a pellet containing 200,000 DCs cells, which was then homogenized. Thirty mi-

croliters of hot (70�C) 3 3 SDS–PAGE sample buffer containing 10 mM DTT was added to the homogenate, followed by boiling for

10 min. Particulate matter was pelleted by centrifugation at 16,0003 g for 1 min, and the supernatant was transferred to a fresh tube

for analysis by SDS–PAGE.

Western blotting
Protein was resolved by 10% SDS–PAGE and transferred to nitrocellulose membranes. Membranes were blocked with 5% bovine

serum albumin (BSA) or 5% nonfat drymilk for 1 h at room temperature, incubated for 16 h with primary antibody (1:1000 final dilution

in TBST [150 mM NaCl, 20 mM Tris-HCl, pH 7.5, 0.05% Tween 20]) and washed three times for 5 min each with TBST. The washed

membranes were incubated with an appropriate secondary antibody for 1 h at room temperature. Membranes were then washed

three times for 5 min each with TBS containing 0.2% Triton X-100, and immunocomplexes were detected by enhanced chemilumi-

nescence (ECL; Bio-Rad) using an appropriate horseradish peroxidase–linked secondary antibody (Amersham Biosciences) and

developed using a.

ChemiDoc Imaging System (Bio-Rad).

QUANTIFICATION AND STATISTICAL ANALYSIS

Statistical analysis
Prism was used to generate graphs and quantify p values using statistical methods as indicated in the respective figure legends.

Tests, numbers of experiments, error bars, and meaning of p values are shown in each figure legend.

Quantification of immune fluorescence signals
To determine the intensity of the defined protein within the cell.

(1) Open the ImageJ software.

(2) Click the ‘File’ tab, then click ‘Open’ to open the file you want to quantitate. A window will pop up named ‘Bio-Format Import

Options.’

(3) ‘Hyperstack’ and ‘Colorized’ options allow independent analysis of each fluorescent channel collected in the original exper-

iment.

(4) Click on the ‘Split channels’ to obtain three separate windows, one for each of the three color channels, so that the quantitation

of each fluorescent channel can be performed separately.

(5) Hit ‘OK’ at the bottom right of the window to proceed to the next quantification step.

(6) Click on the ‘Freehand selections’ button and then use the drawing pen to circle the area of the cell to be quantitated.

(7) Click the ‘Analyze’ button to select the ‘Measure’ option. A window will then pop up named ‘Results,’ which includes several

measurements that the software made on the chosen area, including Median Intensity. Copy the median value in an Excel

sheet for each cell measured. For example, measure 25–30 cells.
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It is preferable to subtract the background Median Fluorescence Intensity (MFI) from the MFI of a region of interest (ROI) while

analyzing images since the background of an image might affect the MFI quantitation.

(1) Repeat step 7 to select and measure a non-fluorescent area of the same image. MFI of that non-fluorescent area/negative

control image is then subtracted from the tissue area MFI.

(2) Calculate the final MFI = MFI of an ROI – MFI of Background.

(3) Copy and paste the value in Prism to represent results in a diagram and carry out our statistical analyses.

Quantification of western blots signals
To determine the density of bands on a western blot, we used ImageJ sing the protocol reported in (https://imagej.nih.gov/ij/docs/

menus/analyze.html#gels). In brief.

(1) File>Open

(2) The gel analysis routine requires the image to be a gray-scale image. To convert to grayscale, go to Image>Type>8-bit.

(3) Use the rectangular selection tool to outline the first lane. The rectangle should be tall and narrow to enclose a single road.

(4) Select Analyze>Gels>Select First Lane (or press "1"), and the lane will be outlined and "Lane 1 selected" displayed in the sta-

tus bar.

(5) Move the rectangular selection right to the next lane and select Analyze>Gels>Select Next Lane (or press "2"). The desig-

nated lane is outlined and labeled, and "Lane n selected" is displayed in the status bar.

(6) Repeat the previous step for each remaining lane.

(7) Select Analyze>Gels>Plot Lanes (or press "3") to generate the lane profile plots.

(8) Use the straight-line selection tool to draw baselines and drop lines so that each peak of interest defines a closed area.

(9) For each peak, measure the size by clicking inside with the wand tool.

(10) Select Analyze>Gels>Label Peaks to label each measured peak with its size as a percent of the total length of the measured

peaks.

(11) The values from the Results window can be moved to an Excel spreadsheet program to calculate the ratio between the den-

sity of a protein of interest over the density of a protein used as loading control for each sample and treatment.
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